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MANUAL GUIDELINES   

Introduction 

This manual shows you how to use Geotech’s Gas Analyser Manager (GAM) software. 

Notes 

Important/useful information and instructions are shown clearly throughout the manual in a note format.  

 

For example: 

Note: For further information please contact Technical Support at Geotechnical Instruments (UK) Limited on 
+44 (0) 1926 338111 or email technical@geotech.co.uk. 

Biogas instrument users 

Users operating a BIOGAS CHECK or BIOGAS 5000 instrument need only to refer to the following sections of this 
operating manual: 

 

Introduction 
Software Installation and Removal 
Getting Started  
User Interface  
Instrument Communication  
Getting Readings from an Instrument  
Problem Solving  
Glossary of Terms 
 

Note: For GA & GEM range analyser users all sections of this operating manual apply. 
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INTRODUCTION 

This manual explains how to use Gas Analyser Manager (GAM) for the GA2000, GEM2000, Biogas Check and 
5000 series of instruments listed below: 

 GA2000 

 GA2000 Plus 

 GEM2000 

 GEM2000 Plus 

 BIOGAS Check 

 GA5000 

 GEM5000 

 BIOGAS 5000 
 

Note: These instruments are sensitive pieces of scientific equipment, and should be treated as such.  
Instructions in this manual are also applicable to the GA94 and GEM500 gas analysers although no longer 
supported by Geotechnical Instruments (UK) Ltd.   

Gas Analyser Manager 

Gas Analyser Manager (GAM) enables communication with the range of gas analysers listed above in order to 
configure the instruments and download data. The software contains powerful features to help with the 
organisation of data and remote access.   

All data on the PC is stored in metric and converted to the current unit of measurement of the attached 
instrument. 

The main features of GAM are: 

 Organisation and transfer of IDs and readings to/from the gas analyser. 

 Configuration of the gas analyser. 

 Flexible grouping of IDs. 

 Structured organisation of transferred data. 

 Auto detection of instrument type and available options. 

 Secure data mode to prevent tampering. 

 Borehole detection via GPS. 

 Email and FTP of downloaded readings. 

 First time set-up wizard. 

 Facility to import existing Datafield Communications data. 

Compatibility 

The software is designed to run on the following operating systems: 

 Microsoft Windows Vista. 

 Microsoft Windows 7 (32-bit & 64-bit). 

 Microsoft Windows 8.1 (32-bit & 64-bit). 

 Microsoft Windows 10 (32-bit & 64-bit). 
 

The software requires that Microsoft.net V4 components and MDAC 2.8 are installed. These installations will be 
carried out during the software installation. 
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SOFTWARE INSTALLATION AND REMOVAL 

Software installation 

Gas Analyser Manager is provided on CD.  The user installing the software must sign onto the PC with 
‘Administrator’ privileges. 

 

Note: It is recommended that the user does NOT connect the instrument USB cable to the computer before 
installing the software. 

  

Insert the software installation CD into the CD/DVD drive.  The CD should automatically start up and the 
following screen is displayed: 

 

Figure 1 - AutoPlay window 

Click ‘Install Software’ to begin installation (If the CD does not start automatically then use Windows Explorer to 
navigate to the CD and run Setup.exe.). 

 

To install Gas Analyser Manager, agree to the license terms, then click the ‘Install’ button. 

 

Figure 2 - Gas Analyser Manager Setup 
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Windows XP without Microsoft .NET Framework 4 

If the computer is running Windows XP and does not already have the Microsoft .NET Framework V4 installed 
then you will be prompted to restart your computer prior to installation of the framework. Click the ‘Restart’ 
button. After the user has logged back onto the computer the installation process will continue. 

Driver installation prompt 

If the computer is running Windows 7, 8 or 10 then the user will be prompted to confirm the installation of 
drivers. When the following message is displayed, click Install: 

 

Figure 3 - Driver installation prompt 

When the installation has completed the following message appears: 

 

Software removal 

To remove Gas Analyser Manager and all associated files the user must sign onto the PC with ‘Administrator’ 
privileges, otherwise the removal request is denied by the operating system. 

 

To remove the software once installed, select ‘Start’ from the desktop and then ‘Control Panel’. 

 

Select the ‘Add/Remove Programs’ icon, highlight ‘Geotechnical Instruments Gas Analyser Manager’ and select 
‘Remove’.  
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Figure 4 - Removal progress 

Note: Deleting the Gas Analyser Manager application does not automatically remove Microsoft.NET V4 
Framework.  Take into consideration other applications which may use Framework before removing from 
the ‘Add/Remove Programs’ option. 

 

Restart the PC after the software has been removed. 
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GETTING STARTED 

Program start-up 

Once the software is installed connect the analyser to the PC via the USB, serial cable or Bluetooth (if you are 
connecting a G5000 analyser). 

To start the application double-click the desktop shortcut for ‘Geotech Gas Analyser Manager’. 

 

Figure 5 - Desktop Icon 

Alternatively, select ‘Start’ from the desktop, then ‘All Programs’ and select ‘Gas Analyser Manager’ from the 
Geotechnical Instruments program folder. 

Running the software for the first time  

When running the software for the first time, the user will be prompted to register. 

After registration the user is required to specify the data folder in which to store the files, including borehole 
identifiers and downloaded readings. Either, ’Browse’ to choose a new location or accept the default folder. 
 

 

Figure 6- Getting started folder selection 

 At this point the user may also configure advanced settings such as units of measurement or serial ports by 
clicking ‘Configure advanced options’.  Alternatively, these options may be changed at any time by selecting 
‘Tools’ then ‘Options’ from the menu bar within the Gas Analyser Manager application. 

Exiting the application 

To exit and close the Gas Analyser Manager application, select ‘File’ from the drop down menu then ‘Exit’ or, 
click on the ‘X icon’ at the top right of the application window.  

 

Figure 7 - File Menu 



   Page 12 of 59 

Operating Manual 

OMGAM – Iss. 2   Copyright – Geotechnical Instruments (UK) Ltd 

GAM 

USER INTERFACE 

Default application screen 

The default application screen displays the ‘Sites’ tab.  The main areas of operation are divided into seven tabs 
across the top of the main window.  The most common operations are available on the toolbar below the drop 
down menu options.  The status bar along the bottom of the screen shows the instrument’s connection status; 
when a connection is in progress the serial number and type of instrument is also shown. 

 

Figure 8 - Gas Analyser Manager main window 

Drop down menu options 

The drop down menu options enable the user to select specific tasks.  Move the cursor along the tabs to display 
the options available. A number of options may be displayed in grey text, indicating that that particular option is 
not available at that time. 
 

Toolbar 

The toolbar displays the most common tasks performed by the user.  Click on the relevant toolbar icon to action. 

Application tabs  

There are seven application tabs available to the user.  The user may move freely from tab to tab.  Most tabs 
require that an instrument is connected to the PC. 
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Search 

The search facility enables the user to enter in search criteria about the sites created.  For example, enter a 
borehole ID or first few characters of the search criteria and select the ‘Find’ button.  If a match is found the data 
will be displayed. 

 

User defined settings 

The user defined settings lists a hierarchy tree of folders that have been set up by the user, i.e. Site, Borehole 
Groups and IDs.  Click on the + next to the folder name to drill down further and display folder/file content.  Click 
on the – to close the folder information. 

 

Selected tab information 

This window displays the information and fields relevant to the tab selected by the user. 

 

Status bar 

The status bar along the bottom of the screen shows the instrument’s connection status, i.e. grey when not 
connected, yellow whilst searching for an instrument on a serial port and green when an instrument has 
successfully been detected.  The instrument’s serial number and model type are shown.  The bottom line 
contains status information and communication error messages.  The progress bar updates when downloading 
readings and uploading borehole ID information. 

Drop down menu options  

Click on each menu tab to display the options available.  The option is only available to the user if it is displayed 
in black text (greyed out text is not available for selection). 

File menu 

New Site  Select ‘New’ then ‘Site’ to define and set up new site information. 

New Borehole 
Group  

Select ‘New’ then ‘Borehole Group’ to create, edit and delete multiple borehole 
groups. 

New ID  Select ‘New’ then ‘ID’ to create, edit and delete new borehole IDs. 

New Route  Select ‘New’ then ‘Route’ to create, edit and delete borehole routes created for ease of 
use by the Site Engineer. 

Import  Select ‘File’ then ‘Import’ to select and import an existing data file into GAM. 

Export 
Configuration  

Export configuration enables the user to export the configuration file from the existing 
PC.  For example, if an organisation has a central database which holds all regional 
data, for speed, the settings may be exported into a new site database. 

Save Location Data 
As KML  

This option enables the user to save the current borehole locations identified using the 
GPS tracking feature as a ‘.kml’ (Keyhole Marking Language) file.  The saved file and 
borehole locations may then be viewed using Google Earth, Google Maps or Microsoft 
Virtual Earth to visually locate each borehole location. 
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Exit  Exits the application and returns the user to the Windows desktop. 

Edit menu 

Delete  Select ‘Edit’ then ‘Delete’ to delete the selected item. 

Edit  Select ‘Edit’ then ‘Edit’ to update the selected item. 

Cancel Changes Select ‘Edit’ then ‘Cancel Changes’ to cancel the last changes made. 

Save Changes Select ‘Edit’ then ‘Save Changes’ to save the changes. 

View menu 

Reading Download 
Set-up 

Select ‘View’ then ‘Reading Download Set-up’ to set-up the default rules when 
downloading data. 

Refresh Select ‘View’ then ‘Refresh’ to refresh the screen displayed. 

Instrument menu 

Connect  Select ‘Instrument’ then ‘Connect’ to connect GAM to the attached device. 

Download Readings Select ‘Instrument’ then ‘Download Readings’ to download readings from the 
instrument into GAM. 

Get IDs  Select ‘Instrument’ then ‘Get IDs’ to get IDs. 

Upload Data Select ‘Instrument’ then ‘Upload Data’ to upload data settings from GAM to the 
instrument. 

Disconnect Select ‘Instrument’ then ‘Disconnect’ to disconnect the instrument correctly from GAM 
before exiting the application. 

Tools menu 

Options Select ‘Tools’ then ‘Options’ to configure serial port and application set-up options. 

Help menu 

Contents Select ‘Help’ then ‘Contents’ to search and view help text.  The GAM application is 
installed with extensive help text available to the user.  The user may either enter 
search criteria, or click on the folder topic to expand the detail. 

About Select ‘Help’ then ‘About’ to display information about the version of GAM currently 
installed. 
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Toolbar buttons 

  

 

The ‘New’ button creates a new item depending upon the currently selected tab and item.  
Other items can also be created by clicking the drop down button on the right-side of the ‘New’ 
button. 

 

The ‘Edit’ button puts the currently selected item into edit mode.  If the selected item cannot be 
edited this button will be disabled.  During editing the ‘Save’ and ‘Cancel’ buttons are available. 

 

The ‘Cancel’ button aborts the changes to the item currently being edited, reverting the data to 
its original state. 

 

The ‘Save’ button saves the changes to the item currently being edited. 

 

The ‘Delete’ button deletes the currently selected item. 

 

The ‘Connect’ button when selected begins polling the serial port for the Geotechnical 
Instruments Gas Analyser.  When one is discovered the ‘Instrument Status Bar’ turns green. 

 

The ‘Disconnect’ button ends the communication with the current instrument.  The option is 
enabled only when an instrument has been found. 

 

The ‘Download’ button begins the download of readings from the instrument to the GAM 
application. 

 

The ‘Upload’ button begins the upload of IDs, question files and comment files from the GAM 
application to the analyser.  The item uploaded is determined by the currently selected tab and 
item. 

 

The ‘Configure’ button allows the instrument communication settings to be modified and 
configuration of other software settings. 

 

The ‘Data Setup’ button allows the format of the reading data files to be configured. 

 

The ‘Import’ button allows previously exported configurations to be re-imported. 

 

 

The ‘Export’ button allows the user to export the system configuration for backup purposes, for 
importing onto another installation or for problem diagnostic analysis. 
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Application tabs  

After configuring the software the user is presented with the main application screen which has the following 
seven application tabs available for selection. 

Sites 

The ‘Sites’ tab is the main window for configuring the ‘Borehole IDs’, ‘Reading Download Options’ and a folder 
tree view showing the sites, borehole groups, IDs and download data. 

Comments 

The ‘Comments’ tab enables the creation, editing and deletion of comment files.  Comment files are used in 
singe/multi-choice site and borehole questions.  

Site questions 

The ‘Site Questions’ tab enables the creation, editing and deletion of site questions files. 

Routes 

The ‘Routes’ tab enables the grouping of borehole IDs by site or borehole group.  

Technicians 

The ‘Technicians’ tab enables the creation of technician ID codes. 

Instruments 

The ‘Instruments’ tab shows a list of all instruments that have been connected. 

Instrument 

The ‘Instrument’ tab enables the configuration of the instrument and calibration dates to be checked. 

Terminology 

This section provides a brief explanation into some of the terms used throughout GAM. 

Sites 

A ‘Site’ is a group of boreholes within a common location.  Boreholes within a site are identified by one or more 
matching characters in the borehole ID.  Usually the first few characters of an ID are fixed.  If not using a 
common set of characters in the ID, sites can still be created to organise the data. 

Within GAM a site is uniquely identified by its ‘Site Name’.  Within a site, boreholes may be subdivided into 
groups.  For instance, you may wish to group types of borehole by location within the site, or by reading 
frequency requirements. 

Another common aspect of a site is that the boreholes share the same comment files and site question files.  
When using a GA94 or GEM500 instrument ‘Site Questions’ are not used and therefore this parameter is 
ignored. 

Borehole groups 

A ‘Borehole Group’ identifies a set of boreholes within a site. The nature of the grouping is entirely up to the 
user.  A borehole ID may only exist in one group at a time. A small site may have a single set of boreholes only 
and not make use of grouping. 
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Boreholes 

A ‘Borehole’ is a single sampling point on a site that is identified by a unique label. The borehole can be a well-
head, borehole or any other fixed point where a gas measurement is taken. 

Labels normally have eight characters (0 to 9, A to Z). GA5000/GEM5000/BIOGAS 5000 models that are fitted 
with V1.12.4 firmware or later support up to 12 characters when the feature is enabled on the instrument. 

Question files 

‘Question File’ define up to five site questions that can be answered by the user on a GA2000/GA2000 Plus, 
GEM2000/GEM 2000 Plus or 5000 series instruments. Four styles of question are available; simple text answers, 
value answers, and single or multiple-choice questions from a pre-selected list of comments. 

Up to three borehole specific questions may also be defined. 

Comment files 

A ‘Comment File’ defines a list of up to 64 text strings that are used as the selection choice in the single or 
multiple choice question files for site or borehole specific questions. 

Routes 

A ‘Route’ is a mechanism that allows the pre-selection of several sites, borehole groups or individual boreholes 
for simultaneous uploading to an instrument.  This option is useful where an instrument is used across several 
sites. 

It is also used to enable the user to order the IDs according to the sequence in which the Site Engineer walks the 
route when sampling. You can define several sequences containing various combinations of sites, borehole 
groups and/or individual IDs. 
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INSTRUMENT COMMUNICATIONS 

Introduction 

It is possible to connect GA/GEM2000 instruments via serial port or USB. G5000 platform instruments can 
connect to your computer via USB or Bluetooth. (Geotech do not provide the Bluetooth adapter for your 
computer). 

Connecting via USB or serial port 

Simply connect your analyser to the computer and click the Connect button from the Instrument menu or press 
F9. 

The software will begin searching for your analyser. 

 

Figure 9 - Discovering Instruments window 

To begin communications, click the instrument icon. 

 

Note: With GA94 and GEM500 instruments it is necessary to cycle the power of the instrument and choose 
‘Option 4 – Download’ on the analyser after selecting the ‘Connect’ option. 

GA2000, GEM2000, BIOGAS 2000 series instruments; the instrument must be at the ‘Main Gas Read Screen’ 
before attempting to connect. 

 

When the instrument is found, the ‘Status Bar’ at the bottom of the screen turns green and displays the model 
number and serial number of the instrument.  The ‘Instrument’ tab will now be enabled and the ‘Instrument’ 
option becomes available. 

 

Figure 10 - Main window show instrument connected 
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Select the ‘Status’ tab of the ‘Instrument’ tab and the instrument details will be shown.  To connect another 
instrument select the ‘Disconnect’ button, attach the new instrument, then select ‘Connect’. 

 

Note: All configuration functions of the software can be carried out without having an instrument 
connected.  Instruments need to be connected when uploading a new configuration or downloading 
readings to the computer.   

Gas Analyser Manager can be configured to detect instruments automatically as well as configured to detect 
instruments on multiple serial ports.   

Connecting via Bluetooth 

Note: GA5000, GEM5000 or BIOGAS 5000 analysers only. 

Connecting the analyser first requires that the analyser has been paired with the computer. The process varies 
depending on your computer’s operating system and Bluetooth adapter combination. 

Select ‘Device Manager’ for a list of attached devices. Select folder ‘Ports (COM & LPT)’ to view the USB Serial 
Port number i.e. the above example number is COM6.  

Using Bluetooth with Windows Vista and Windows 7 

These instructions are compatible with Windows Vista Service Pack 2 and Windows 7 Service Pack 1. 

 
1. Switch on the gas analyser and check to make sure that the instrument is Bluetooth enabled.  On the 

analyser, select the ‘Menu’ key followed by ‘Device settings’.  

 

Figure 11 - GA5000 Bluetooth screen 

2. Insert the USB Bluetooth dongle into the computer. 

3. The hardware driver will automatically install.  Follow the ‘Found New Hardware Wizard’ prompts and 
select the ‘Next’ key to continue through the screens until the new hardware has been recognised 
successfully. 

4. Once the new hardware has been recognised the user must establish ‘Pairing’ with the analyser. 

5. Right click on the Bluetooth symbol displayed on the desktop task bar and select the option to ‘Add a 
Device’. 
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Figure 12 - Windows 7 Bluetooth Taskbar menu 

6. Follow the screens through the ‘Add a Device’ wizard as follows: 

 

7. Wait for your gas analyser serial number to display.  The serial number of the gas analyser can be found 
on the label on the back of the instrument.  Click on the device when displayed to select. 

 

8. Click on the option to ‘Enter the device’s pairing code’. 
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9. Key in device’s pairing code (instrument serial number) and select ‘Next’. 

 

Figure 13 - Windows 7 device is ready to use message 

During the driver installation the ‘Pairing’ number will identify the COM port number. Make a note of the COM 
port number displayed in the first line.   

Gas Analyser Manager will now be able to detect your analyser. Press F9 or choose Connect from the Instrument 
menu. 

How to identify the COM port number using USB cable 

For all instruments using Windows XP, Vista or Windows 7 operating systems. 

 

Attach the USB lead to the gas analyser and switch on the analyser.  Plug the USB lead into the PC and select 
‘Start’.  Right click on ‘Computer’ then select ‘Manage’. 

 

Note: For Windows XP right click in ‘My Computer’ then select ‘Manage’. 

 

The following screen is displayed: 
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Figure 14 - Windows Device Manager 
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OPTIONS 

General settings 

To change the configuration of the software, select ‘Options’ from the ‘Tools’ menu and the following options 
are available: 

 

Figure 15 - Tools Options window 

Data folder 

This is the folder where the configuration including download readings are stored. This should be a folder where 
you have read/write permissions and it may be on a shared network folder. 

Maximum ID length 

This setting allows the maximum length of the sample point (borehole) ID to be increased from the standard 
value of 8 characters up to a new maximum of 12. 

This feature also requires you to have a compatible GA/GEM/BIOGAS5000 instrument. This requires V1.12.4 
firmware or later. 

Once you change the maximum ID length you can upload the IDs to the instrument. When you do this for the 
first time you will be warned and given the chance to reconfigure your instrument to allow more than 8 
characters. 

Note: If you enable this feature and also have older models of instrument, IDs can still be uploaded to those 
instruments but the labels will be truncated, so you should take care not to create duplicates in this way. 

ID Question Count 

Newer variants of the G5000 platform analysers can support more than 3 ID questions. To enable this feature 
you also need to change this setting to match the number of questions you wish to use. 

Lat/Long display format 

‘Latitude and longitude coordinates’ can be associated with each ID. Choose the default display format. Either 
‘Decimal’ (e.g. 52.123567) or ‘Degrees, Minutes, Seconds’ format (e.g. 52° 32m 12.231s). 



   Page 24 of 59 

Operating Manual 

OMGAM – Iss. 2   Copyright – Geotechnical Instruments (UK) Ltd 

GAM 

GPS distance warning 

When viewing readings downloaded with coordinate data, the software can compare the original location 
specified against the ID with the location of the instrument when the reading was taken. 

When the distance is more than the amount specified in this parameter the reading's row is highlighted in red. 

Automatic clock synchronisation 

The ‘Automatically Synchronise Instrument Clock’ option enables the instrument’s internal clock to be set to that 
of the computer each time a connection is established.  This option is not set during the initial ‘Setup Wizard’; 
the setting can be changed at any time.  

Show speed upgrade prompt 

The latest GA2000 and GEM2000 analysers have the ability to communicate at twice the rate of old analysers. 
Ticking this option will cause the user to be prompted to upgrade the speed of an analyser when it connects.  
When the upgrade is applied, the instrument will switch off and you will have to restart the instrument.  

GA94/GEM500 date format 

If you are using GA45, GA94 or GEM500 gas analysers select the date format of your instrument. 

Units of measurement 

Select either ‘Metric’ or ‘Imperial’ units of measurement, this is the unit of measurement the software uses and 
is entirely independent of the configuration of your instruments. However to avoid confusion you should ensure 
that you configure your instruments to use the same units of measurement. 

Connectivity settings 

 

Connection Method – Advanced settings 

Advanced settings allows the user to use the old method of discovering and connecting to gas analysers. To use 
this option tick the Advanced settings checkbox.  
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Serial Ports 

All serial ports fitted to the computer are listed. Place a tick next to the serial ports you may attach your 
analysers to or tick ‘Scan all ports’ to have the computer attempt to find a gas analyser on any serial port. 

Connect automatically 

Ticking this option allows the software to continuously scan for an instrument and it will connect and disconnect 
from the instrument automatically. Using this option disables the ‘Connect’ and ‘Disconnect’ options on the 
toolbar. 

Scan all ports  

Tick this box to have the computer scan all serial ports on your computer. You would not wish to enable this 
option if you have other devices connected to some serial ports on your computer. 

Email settings 

 

Email SMTP server settings: 

The email server settings are used by the facility to automatically email readings to a specified address as they 
are downloaded.  

SMTP mail server 

Specify an SMTP mail server to make use of the option to automatically email readings as they are downloaded. 
Specify an IP address or mail server domain name, e.g. mail.mycompany.com  

Username 

Specify the username required to logon to the SMTP server. If a domain name is also required, precede the 
username with the domain name followed by a backslash. For example: domain\username  

Password 

Specify the password of the username required to logon to the SMTP server.  
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Sender email address  

If you specify an SMTP mail server you need to also specify a sender's email address, as a valid internet-format 
email address.  

Test button 

To test the email settings click the 'Test' button.  An email will be sent to the Sender email address. A success 
message or error message will be displayed.   

Select the ‘OK’ button to accept the changes or ‘Cancel’ button to exit without saving the changes. 
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SITE, GROUP AND ID SETTINGS 

Define site settings process – best practice  

Double-click on the ‘GAM application’ icon on the desktop to start the application and check that you have 
connection from the analyser to PC and that the status at the bottom of the application screen reads connected. 

Note: It is best practice to set up ‘Steps 1 and 2’ before ‘Step 3 - Site Name and Site Details’. During the site 
set up, the user will be asked to select the ‘Comments File’ and ‘Site Questions File’ attached to that site.  

 

1. Create a comments file to hold the site and ID question information. 

2. Create up to five site questions. 

3. Create the site name and site details. 

4. Create borehole groups. 

5. Create borehole IDs. 

6. Are you using the GPS Feature? 

a. ‘YES’ Go to Step 7 

b. ‘NO’ Go to Step 8 

7. Enter borehole coordinates. 

8. Create technician IDs (optional). 

9. Create routes. 

10. Upload settings from GAM to the analyser. 

11. Take readings and samples. 

12. Set up the ‘All Received Readings’ option in GAM. 

13. Download data readings from analyser to GAM. 

Note: The analyser must be at the ‘Main Gas Readings’ screen to upload or download data. 

Sites tab 

A ‘Site’ is a set of boreholes at the same location that can usually be identified by a common set of characters in 
the ‘Borehole ID’.   
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Creating a new site 

1. From the ‘Sites’ tab, click the ‘New’ toolbar button or choose ‘New’ from the File menu. 

2. Select ‘Site’ from the menu and the following screen is displayed: 

 

Figure 16 - New site creation 

3. A new ‘Site folder’ item is created; complete the following parameters: 

Site name Enter a short name to identify the site; enter only characters that are valid 
filename characters. 

Description Enter a description of the site. This field is optional. 

Borehole ID prefix If the site can be identified by a set of common characters in the borehole ID, 
enter the characters that are appropriate.  Leave the other characters set as a 
full stop. 

Site question file Select an existing site question file that is associated with this site.  If no site 
question file has been created yet, leave this section blank.  A file can be selected 
once a site question file has been created. 

Comments file Select an existing comment file that is associated with the site.  If no comments 
file has been created yet, leave this field blank.  A file can be selected once a 
comments file has been created. 

 

Note: When creating several sites, ensure that all borehole ID masks are unique and unambiguous.  For 
example, if Site A has a mask of “SITE....” and Site B a mask of “SITEB…” this could lead to confusion because 
Site A’s mask would also be included in “SITEB…”. 

To store the changes, select the ‘Save’ toolbar icon or ‘Save’ from the ‘Edit’ menu. 

Note: Borehole IDs can now be created.  Borehole IDs within a site can be grouped for easier identification 
and use. 

 

Editing site details 

1. From the main ‘Sites’ tab, select the ‘site name’ from the names in the folder tree. 

2. Select ‘Edit’ from the ‘Edit’ menu or select the ‘Edit’ toolbar icon. 

3. Enter the details and select the ‘Save’ button. 
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Note: If a site or site name is changed, the route will need to be modified to reflect the changes. 

 

Deleting a site 

From the main ‘Sites’ tab, select the ‘site name’ by selecting the name in the tree. 

Select ‘Delete’ from the ‘Edit’ menu or click the ‘Delete’ toolbar icon.  

Note: Once a site has been deleted the data cannot be restored.  All associated borehole IDs will also be 
deleted. 

Borehole groups 

A ‘Borehole Group’ is used to organise lists of borehole IDs within a site.  All sites have at least one borehole 
group.  There is no limit on the number of borehole groups that can be created to organise a site’s boreholes; 
you can create as many as you need to organise your site’s boreholes.  A single borehole can only exist in one 
group at a time. 

Creating a group 

Select the site in the folder tree for which a group is required. 

 

Click the ‘New’ toolbar button or select ‘File’ menu item and select ‘Borehole Group’.  A new item will appear 
below the site in the folder tree with the name ‘<New>’. 

 

Figure 17 - New borehole group 

Rename the word <New> with the new group name. 

Note: Borehole IDs will be created under the selected borehole group. 

Editing the group’s name 

The name of a group can be edited by clicking a second time on the group name in the tree or by entering ‘Edit’ 
mode and editing the name in the borehole ID list in the right-hand window. 

Deleting a group 

Click on the borehole group name and select the ‘Delete’ button.  All borehole IDs in the group will be deleted 
permanently. 
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Re-ordering borehole IDs within the group 

The order of the borehole IDs in the group will be the order in which they appear in the instrument.  It is useful 
to set the order of the IDs to match the order in which they are typically read on site.   

In addition to setting the order within the group, if required, a different ordering can be used when creating 
routes. 

1. Select the group name in the folder tree. The right-hand panel shows a list of borehole IDs within the 
group. 

2. Select the ‘Edit’ button from the toolbar or menu. 

3. Borehole IDs can be moved using the shuffle buttons (up/down arrows) on the left-hand side or by 
dragging and dropping one or more items in the list. 

4. Select the IDs to be moved using the mouse.  To select several IDs at the same time use the Shift and Ctrl 
buttons to make multiple selections. 

Moving borehole IDs to a different group 

As with moving IDs within the same group, select the IDs to be moved.  Then, using the mouse, drag and drop 
the items into the new borehole group entry in the tree. 

Editing borehole ID details from the group list 

One or more borehole IDs to be edited can be selected by choosing the ID from the appropriate group.  Either, 
click a second time on the borehole ID or right click and choose ‘Edit’ from the context menu that appears.  To 
edit more than one ID at the same time, select the IDs as described above, right click and choose ‘Edit’ from the 
context menu. 

Note: For Gas Analyser Manager Versions prior to version 1.1, when editing more than one borehole ID at 
once all IDs will be given the same properties except for the borehole ID value. 

Borehole (sample point) IDs 

All references to borehole IDs include well-heads and any other identifiable location where gas readings and 
flow measurements are taken.  For each borehole ID users can specify which types of Geotechnical Instruments 
Gas Analyser are used with the borehole.   

 

With GA45/GA94 type instruments only the borehole ID and whether or not pressure data is read can be 
entered.  With GEM500 and GEM2000 instruments the flow device and associated parameters can also be 
specified.   

 

For GA2000/GA2000 Plus, GEM2000/GEM2000 Plus and 5000 series instruments the user can enter the 
comment text, pump run-time and up to three borehole questions.  

Note: If you use a combination of instruments, a single configuration can be used.  There is no need to 
generate separate data for each type of instrument.  When configuration data, i.e. borehole IDs are sent to 
an instrument, the software works out the type of instrument and appropriate settings to ensure the 
relevant data is stored to the instrument. To enable an instrument type to receive an ID, ensure the 
checkbox is ticked. 
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Borehole parameters 

The borehole editor form has the following parameters: 

 

Figure 18 - Borehole parameters 

Parameter 

ID(s) 

An identifier for a borehole of between 8 and 16 characters.  An identifier can consist of letters and/or numbers 
in any combination.  Uppercase letters are considered different to lowercase letters.  

Sample point type  

Select from a drop down box.  Choose from other, well, probe, sample port, horizontal collector or biogas. This 
setting is for information only. 

Prompt to read relative pressure / system pressure  

When selected, the instrument will prompt the user to take a relative pressure reading from the borehole or 
wellhead. This setting applies to GA2000 models only. 

Record borehole flow 

When selected, the user will be prompted to record flow using the internal flow sensor.  

Prompt to fit H2S filter  

This option allows CO readings to be taken where there are high levels of H2S  present. 

Information 

Enter any information considered useful to the operator.  This text can be viewed on the instrument by the user; 
enter details that enable the user to locate the borehole or wellhead. 
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Flow device  

From the list choose the type of flow device.  Depending on the flow device, enter pipe diameter and orifice 
diameter information in the adjacent fields. 

Longitude and latitude 

Specifies the global position of the ID using latitude and longitude coordinates. If the location is unknown leave 
these values as 0.0. 

You can toggle the default display format by selecting ‘Options’ from the ‘Tools’ menu. Alternatively, to toggle 
quickly between the two formats available right click on the value and choose the display format from the menu. 

Coordinate data can also be set using the ‘Manage location data’ option when viewing previously downloaded 
readings. 

Internal pipe diameter 

When required, enter the pipe diameter.  Note the units of measurement shown. 

Orifice diameter  

When required, enter the orifice plate diameter. 

Pump run time 

Enter the pump runtime.  

Record another relative pressure reading after gases 

GA5000 models of instrument with V1.12 firmware or later can take two pressures. Tick this box to have these 
instruments prompt the user to take a second relative pressure reading. 

Questions  

Enter specific questions for the sample point. The default number of questions is three. This value can be 
changed on Tools Options. However, only G5000 platform instruments with V1.12 firmware can accept more 
than three questions. 

Alarms and Targets 

The conditions specified here cause the instrument to highlight the readings on the live readings screen.  

Alarms 

On G5000 platform models, the readings are indicated with an orange coloured background.  

Targets 

On G5000 platform models, the readings are indicated with a green coloured background.  

Note: Some models of instrument only support "Less than" and "Greater than" alarm type conditions on the 
basic gas channels. GA5000, GEM5000 and BIOGAS 5000 models with V1.12 now support a greater type of 
alarm conditions as well as "Targets". Where an instrument does not support the specified alarm type it will 
be ignored by the instrument. 

  
Remember to click Save after changing the conditions.  
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Add Adds a new condition to the sample point. Click Add to add the new condition and then choose 
the Channel from the drop down list. Then type of trigger, either "Alarm" or "Target". Followed by 
the condition to cause the trigger.  

Delete Deletes the selected rows from the list of triggers.  

Creating new boreholes 

In the folder tree view of the ‘Sites’ tab, select the borehole group in which the ID needs to be created, select 
the ‘New’ toolbar button or ‘New - Borehole ID’ menu item on the ‘File’ menu. 

Creating a new block of sequential borehole IDs 

If using blocks of borehole IDs that share or mostly share the same parameters, a block can be created easily 
using the ‘Create Sequential Block’ option available when creating a new borehole ID.   

 

1. Select ‘New Borehole ID’ from the ‘File’ menu.  

2. Select the button adjacent the borehole ID field labelled ‘Create Sequential ID Block’. 

 

Figure 19 - Create Sequential ID Block 

3. The ‘Mask’ field shows the borehole ID mask specified for the site.  Fill in the remainder of the characters 
with those characters that will be common among the group.  To create the numeric or alphanumeric 
(A..Z,0..9) sequential list, enter a # symbol for numeric characters or @ symbol for alphanumeric. 

4. In the field ‘Start value’ enter the first value.  In the field ‘End value’ enter the final value. 
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In the ‘Start value’ and ‘End value’ fields, key in the same number of characters as the number of # and @ 
symbols specified in the ‘Mask’ field.  

In the ‘Mask’ field all character spaces must be filled in with a letter, number, # or @ character. 

 

For example: 

Mask Start Value End Value Result 

LEAXXX## 12 56 LEAXXX12,LEAXXX13,...,LEAXXX55,LEAXXX56 

LEABB@#Q A8 B3 LEABBA8Q,LEABBA9Q,LEABBB0Q,...,LEABBB3Q  

 

5. Select ‘Preview’ to view a list of the IDs that will be created when saving the data. 

 

Figure 20 - Create sequential ID block 

6. Once the values shown in the Preview list are complete, select ‘Create’ to return to the borehole ID editor 
where the configuration details of the borehole can be added. 

7. Select the ‘Save’ button to store the new boreholes to the borehole ID list. 

Editing an existing borehole ID 

From below the borehole group tree item on the sites tab, select the ‘ID’ and then click the ‘Edit’ icon on the 
toolbar.  Alternatively, choose an ‘ID’ from the ‘Borehole Group’ list and click a second time on the item to 
switch to the borehole details view. 
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Searching for an ID 

To search for a specific ID, enter the ID in the text box label ‘<search>’ and select ‘Find’. If the specified ID exists, 
the ID will be selected in the tree. Partial IDs may also be entered. 

GPS option 

In order to utilise the GPS feature on our instruments, borehole IDs must be created with ‘longitude’ and 
‘latitude’ coordinates predefined then uploaded to the instrument before readings are taken.  Specify; degrees, 
minutes, seconds or decimal angle. 

 

Key in longitude and latitude coordinates for GPS feature 

Note: Not all G2000 and G5000 instruments will have GPS, as it’s an optional feature.   

Manage location data 

After taking readings containing coordinate data, download the readings to the PC using the ‘Download’ button 
on the toolbar. 

 

Green Highlighting: Indicates that the readings coordinates are within the tolerance specified (default 16 
metres) of the sample point's defined location. 

 

Red Highlighting: Indicates that the readings coordinates are outside the tolerance specified (default 16 metres) 
of the sample point's defined location.  

 

Yellow Highlighting: Indicates that the readings have new coordinates and the ID does not yet have any location 
data defined. 

 

Select the ‘Manage location data’ button to update the ID definition with new coordinates. 
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Figure 21 - Manage locations window 

Note: The ‘Location Difference’ column is always shown when latitude and longitude information is stored, 
regardless of whether or not it is included in the saved data file.  To update the master location for an ID 
click the ‘Manage Location data’ button at the top right corner. For each ID you wish to update click the 
‘Update Records’ check box at the end of the row and then click the ‘Apply’ button at top right of the 
window. 

Borehole questions 

GA/GEM2000 (Plus), GA5000 and GEM5000 instruments can be configured to prompt the user to answer up to 
three borehole questions defined on a per-ID basis when the reading is stored relating to the status of the 
borehole or wellhead. 

 

There are four types of question:  

Alphanumeric The user is prompted by a question to input any letter or number as an answer 
up to 72 characters in length.  The user is shown a single prompt. 

Numeric The user is prompted by a question to enter a value in a specific format as an 
answer.  The user is prompted to enter one or more values and a unit of 
measurement is required to answer the question. 

Single selection comments The user is shown a list of up to 10 comments. Only one answer can be 
selected. 

Multiple choice selection 
comments 

The user is shown a list of comments.  Up to eight answers can be selected by 
placing a tick mark next to each choice. 

 

Number of Questions per ID 
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Newer models of the G5000 range can support more than 3 ID questions when used in conjunction with Gas 
Analyser Manager V1.8 or later. 

To enable this option use Tools, Options in this software to specify the maximum number of questions that you 
wish to specify. 

 

When you upload the IDs with more than 3 questions to an instrument that supports the feature 
you will first be prompted to enable the feature on the instrument. This is a one-time option and 
you cannot revert to less than 3 questions afterwards. 

 

  



   Page 38 of 59 

Operating Manual 

OMGAM – Iss. 2   Copyright – Geotechnical Instruments (UK) Ltd 

GAM 

COMMENTS TAB 

Comments files are used by site questions and borehole questions to allow the user to select one or more 
textual comments.  There are two types of question that use the comments: single selection and multiple-
selection comments. 

Questions are currently only available on GA2000, GEM2000, GA5000 and GEM5000.  If you are not using one of 
these instrument types, ignore this section. 

An instrument can have up to 64 comments of up to 35 characters in length.  Comments are organised into files, 
only one file can be used at a time by an instrument and the file used is selected on the ‘Site Properties’ form. To 
ensure consistent usage site questions specify the comment file to be used when a comment-type question is 
selected. 

If using multiple choice comments on a site question the user is limited to selecting ten comments.  For borehole 
specific questions the user is limited to choosing eight comments in total.  This means that if, on a single 
borehole, three multiple-choice comments questions are chosen the total number selected is limited to eight; 
for example three on the first, four on the second and then only one can be selected on the third. 

Creating a new comments file 

1. Select the ‘Comments’ tab and either choose ‘New’ from the ‘File’ menu or toolbar button.  Up to 64 
phrases can be entered, one per line in the edit window. 

2. A number of useful pre-defined phrases can be added to the list of comments. Select the ‘Add Standard 
Comments’ button.  A menu of choices is shown.  Select an option to add the comments to the new file. 

3. Select ‘Save’ to store the new comments.  When creating or editing a set of site questions, the new 
comment file can now be selected from the drop down list. 

 

Figure 22 - Comments tab 
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Editing an existing comments file 

1. Select the ‘Comments’ tab and choose the file from the drop down list. 

2. Enter Edit mode by clicking ‘Edit’ on the toolbar. 

Note: It is not recommended to delete an entry from the file by removing the row.  This will cause problems 
to existing questions that are using the file.  Instead you can re-use the row or leave it as an empty row. 

Deleting an existing comments file 

To delete an existing comments file, select the correct ‘Comments File’ and choose ‘Delete’ from the ‘Edit’ menu 
or toolbar. 

Note: All sites that use the comments file need to be modified so that they do not refer to the deleted file. 
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SITE QUESTIONS TAB 

Question files are used with the GA, GEM 2000 (Plus) and 5000 series instruments only. 

The ‘Site Questions’ tab allows users to specify additional information that the instrument cannot read for itself.  
The type of information is up to the operator.  Up to five site questions can be stored in the instrument.  These 
can, for example, relate to the weather or the operator name.  

 Site questions are answered by the operator choosing an option from the ‘Instrument’ menu.  Borehole 
questions are defined on a borehole specific basis; up to three questions can be defined.  Borehole questions 
can be used to prompt the user to enter information relating to the status of the borehole or wellhead. 

Creating a site question file 

Select ‘New Site Question’ from the ‘File’ menu or select the ‘Site Questions’ tab and then select <<New>> from 
the drop down list. 

 

Figure 23 - Site questions tab 

Enter a file name for the site questions and click ‘OK’. 

 

Up to five questions can be created.  Select the question type from the ‘Question Type’ drop down list.   

 

There are four types of question: 

Alphanumeric The user is prompted by a question to input any letter or number as an answer 
up to 72 characters in length.  The user is shown a single prompt. 

Numeric The user is prompted by a question to enter a value in a specific format as an 
answer.  The user is prompted to enter one or more values and a unit of 
measurement is required to answer the question. 
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Single selection comments The user is shown a list of up to 10 comments. Only one answer can be 
selected. 

Multiple choice selection 
comments 

The user is shown a list of comments.  Up to eight answers can be selected by 
placing a tick mark next to each choice. 

 

Select ‘Save’ on the ‘Edit’ menu or toolbar when the questions have been completed. 
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ROUTES TAB 

IDs in the instrument can be organised in a way more suited to the site technician’s method of monitoring by 
creating one or more ‘Routes’.  A ‘Route’ is a collection of sites, borehole groups or individual boreholes 
programmed into the instrument in a single block.  When uploading a route all existing IDs, questions and 
comments are first deleted from the instrument. Multiple routes can be created and stored for later use.  Create 
different routes to reflect your site monitoring requirements. 

Creating routes 

Select ‘New Route’ from the ‘File’ menu option or select the ‘Routes’ tab followed by the ‘New’ toolbar icon. 

Enter a name for the route in the ‘Selected Route’ text box. 

 

Figure 24 - Routes tab 

Under ‘Available Sites and Groups’ the full list of sites and borehole groups are shown. By clicking a borehole 
group the full list of borehole identifiers for that group is shown in the ‘Available IDs’ list. 

You can view a whole borehole group by selecting the group name and then selecting the right arrow button 
adjacent to the list. 

Adding a site or borehole group to the list will cause all borehole IDs in existence at the time of upload to be 
sent, not just those that existed when the route was created. 
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You can select individual borehole IDs by choosing one or more items from the ‘Available IDs’ list. Use the Ctrl 
and Shift keys when selecting to easily add sets of IDs. 

After adding the items the order can be adjusted by selecting the items in the ‘Selected IDs’ list and using the up 
and down arrow buttons on the right-hand side. 

Select ‘Save’ to store the changes.  The route can now be used with any instrument. 

Creating a route does NOT, in anyway, change the structure of your sites and IDs outside of the defined route, 
enabling you to define them in any order without affecting the master list of sites, borehole groups and IDs as 
defined on the ‘Sites’ tab. 

Uploading routes 

Uploading a route will clear existing IDs, comments and site questions from the instrument. 

The comments and site questions uploaded will be those defined against the site properties of the first ID 
uploaded.  A warning message will be displayed if a conflict of site questions and comments is found.  In this 
case you should check which files are correct and ensure that the selection is consistent. 

Routes on G5000 analysers with V1.12 firmware and above 

These instruments can support multiple route definitions in the instrument. 

To upload more than one route to the instrument tick the Route Names you want to upload and then click the 
Upload button. 

Hide ID from route in instrument after reading 

 When this option is ticked the list of IDs in the displayed list for this route are hidden after a reading is taken. 
This makes it easier to see what work is left to do for the route currently being used. 

 The flag is cleared after the readings are download to the PC using Gas Analyser Manager. 

 The ID is not deleted from the instrument. It is still possible to take another reading. To do this chose the ID 
from the ID filter view rather than via the Route filter. In this case the Id is shown with a line through it to 
indicate a reading has been taken. 
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TECHNICIANS TAB 

GA2000, GEM2000, GA5000 and GEM5000 gas analysers have an option that allows a technician identifier to be 
recorded against each reading taken.  When the instrument is started a list of technician identifiers and names is 
shown. The operator selects their name from a list or they can type in a custom ID.  The ‘Technicians’ tab allows 
the user to create a list of ‘Technician IDs’ and names to be uploaded to the instrument. 

From the ‘Technicians’ tab, select ‘Edit’ to enter edit mode and then enter IDs and names in the list. 

 

Figure 25 - Technicians tab 

Once you have completed adding or editing names select the ‘Save’ button. 

 

Make sure the analyser which is to receive the upload is connected.  Finally, select the ‘Upload’ button to send 
the list to your instrument.  Existing technician names in the instrument are deleted. 

 

Note: The ‘Upload’ option is not available if your instrument does not support the feature or it has not been 
purchased for the instrument. 
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INSTRUMENTS TAB 

The ‘Instruments’ tab displays useful instrument information for the instrument(s) which are connected. 

For example; serial number, model, instrument Firmware Version, model, next service due date, date last 
connected, date last field calibration and last factory calibration date. 

 

Figure 26 - Instruments tab 

Note: The GA2000 Plus instrument listed above is highlighted in red indicating that the next service due date 
has passed. 
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INSTRUMENT TAB 

Instrument maintenance and status information can be obtained by selecting the ‘Instrument’ tab.  

 

Figure 27 - Instrument tab 

Instrument settings  

The ‘Instrument’ tab has the following sections: 

Status Shows calibration dates, instrument type, battery and memory status and Firmware 
version information. 

Switches Allows the setting of auto-purge setting, auto power-off, low flow warning sensitivity, 
purge pump run-time and technician log-in enable. 

Alarms For the setting of instrument alarm levels for CH4, CO2, O2 and Residual N2 where 
supported by the instrument. 

Logging For setting auto logging parameter ID, interval and pump run-time. 

Delete Allows the deletion of various parameters and cold-start of the instrument. 

Event Log Only available with GA2000 and GEM2000 analysers which have purchased with the Event 
Logging option. 

The Event Log shows system activity within the analyser including when user-calibrations 
are performed and the values obtained during the calibration.  This information can be 
saved to a file by clicking the ‘Save As…’ button. 

 Also when readings are downloaded from the instrument the software can be configured 
to put the calibration data from the Event Log into the CSV (or other) file, either in the 
header block or in-line chronologically with the readings. 

To edit instrument settings the analyser must be connected. Select the ‘Edit’ button on the toolbar or ‘Edit’ 
menu, make the required changes and then select the ‘Save’ button to commit the changes to the instrument. 
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Instrument screens: 

 

Figure 28 - Instrument status 

 

Figure 29 - Instrument switches 
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Figure 30 - Instrument alarms 

Alarms can only be set with the instrument attached.  An audible and visible alarm indication occurs on the 
instrument when the specified channel’s reading falls below or rises above the specified value.  

 

Figure 31 - Instrument logging 
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Specify an interval between readings time frame and pump run time. 

 

Figure 32 - Instrument delete options 

To delete stored and downloaded readings, tick the relevant options and then select the ‘Execute Command’ 
button. 

 

Figure 33 - Instrument event log 

The event log shows system activity with the analyser. 
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IMPORTING AND EXPORTING FILES 

Importing question and comment files 

To import question files and comment files select ‘Import’ from the ‘File’ menu or, select the ‘Import’ toolbar 
button. 

Select one or more files to import. After importing the file it is available for selection from the ‘Site Questions’ 
tab. You no longer need to keep your existing files.  

Importing borehole IDs 

Importing an ID file is just the same as importing questions and comments; however the following points should 
be noted: 

The IDs in the imported file will be analysed and moved into the appropriate Site. 

For a Site with more than one Borehole Group, the IDs will be placed into the first Group in the list unless the 
user selects the ‘Group Name’ in the tree before selecting to import. 

Where no matching ‘Site Borehole ID Mask’ is found a new Site will be created. When you have specified an 
empty borehole ID mask (........) the IDs will be stored in that Site. 

Note: Files cannot be converted back to DFC file formats. 

Importing a system configuration 

The Gas Analyser Manager Export Configuration option creates a file with the extension .DVE. These files can be 
imported back into Gas Analyser Manager. 

1. Select ‘Import’ from the ‘File’ menu or select the ‘Import’ toolbar icon. 

2. Select the backup file to ‘Import’ then click ‘Open’.  

3. Select the Site or Sites to import to files into.  

4. Select the method of import from the ‘Import Mode’ list. 

Delete all existing sites, 
groups and borehole IDs 

This option will overwrite, without warning all existing configuration data 
including all borehole details. Existing readings will remain intact. 

Only add new sites, groups 
and IDs  

This option will only add Sites and the associated data that do not 
already exist. 

Add new, overwrite 
existing data without 
prompting  

This option will merge the current configuration and new data in the 
Export file. You will be prompted before overwriting any existing 
borehole configurations. 

Add new, prompt to 
overwrite 

This option will merge the current configuration and new data in the 
Export file. You will not be prompted before overwriting any existing 
borehole configurations. 

5. When you have chosen the sites and import mode select the ‘Import’ button. 
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Exporting the system configuration 

This enables the user to export the system configuration for backup or transfer to a different computer by using 
the ‘Export Configuration’ option.  This facility is also useful for diagnostic analysis by the Geotech Technical 
Support team should they require a copy of your configuration in order to identify a problem. 

Connect to an instrument, select the ‘Export’ toolbar button and the following screen is displayed: 

 

Figure 34 - Export Configuration dialog 

Place a tick next to the Site(s) you wish to export and then select the name of an export file to hold the exported 
configuration. To browse for a file click the [...] button. 

Select the ‘Export’ button to export the data. If the specified file does not exist you will be prompted to create 
the file.  Specify a file name placing the file in a preferred folder on your computer. 

The following message displays when the file export has been successful. 

 

The exported file can now be used as a backup of the configuration or for importing into another system. Select 
‘Save’ to store the configuration.  The file can now be sent using the preferred email software. The exported file 
contains the borehole details, comments, questions, and Routes you may have created. Downloaded readings 
are not exported. 

 ORGANISING DATA FOR INSTRUMENT UPLOAD 

Configuration data can be uploaded (sent) to an instrument by choosing the item to send from the ‘Site’ folder 
tree, ‘Comments’ tab, ‘Site Questions’ tab or ‘Routes’ tab and clicking the ‘Upload’ button on the toolbar. 
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Borehole ID information can be uploaded in this way by choosing a borehole group within a site or by uploading 
the whole site. 

Activities can be organised in a way more suited to the user’s method of monitoring by creating routes.  A route 
is a collection of sites, borehole groups or individual boreholes programmed into the instrument in a single 
block.  Multiple routes can be created and stored for later use. 

Uploading routes 

Uploading a route will clear existing IDs, comments and site questions from the instrument.  When appropriate, 
new sites and comments can be uploaded to the instrument. 

The comments and site questions uploaded will be those defined against the site properties of the first ID 
uploaded. 

A warning message will be displayed if a conflict of site questions and comments is found. In this case you should 
check which files are correct and ensure that your selection is consistent. 

Uploading configuration data and readings 

To send configuration data to the instrument, click the ‘Upload’ button or choose ‘Upload’ from the ‘Instrument’ 
menu.  The ‘Upload’ option is enabled when a connection has been established and the selected tab or item is 
valid for uploading.  Site question files, comment files, borehole ID groups and routes can be uploaded. 

Uploading readings 

Existing readings can be uploaded back into an instrument. This is useful for GEM instruments for comparison 
with previous readings.  Only readings that have been downloaded with the ‘Secure’ flag set can be uploaded 
back into the instrument. Files must be saved in CSV format.  Make a connection to the instrument; choose the 
file from the list in ‘All Received Readings’ and click the ‘Upload’ toolbar icon. 

Note: This feature is not currently available with the 5000 series of instruments. 
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GETTING READINGS FROM AN INSTRUMENT 

Preparing to download readings 

To set-up the default rules when downloading data select ‘View’ then ‘Reading Download Set-up’ or select the 
‘Data Setup’ toolbar icon and the following screen is displayed: 

 

Figure 35 - View – reading download set-up 

Before downloading readings from the instrument, the following parameters need to be configured: 

 File format to store readings (CSV etc). 

 Secure file. 

 Field settings (the columns of data values and the order in the file that you want to them displayed). 

 Filename format. 

 Naming convention for your data files. 

 Post download processing options. 

Note: With older GEM 2000 instruments it is necessary to switch modes using the instruments on-screen 
menu to download readings stored in each of the two operating modes. For further information please 
contact Technical Support at Geotechnical Instruments (UK) Limited on +44(0)1926 338111 or email 
technical@geotech.co.uk. 

File formats 

To configure the download settings chose from the following options: 

Comma separated values (CSV)  Comma separated values; each row has all data values for a single borehole 
reading.  The actual separator character is determined by regional settings. 

Tab separated values Similar to CSV except each reading value is separated with a tab character. 

MPR monitor pro file format Each row only contains a single channel’s value. 
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Rungas file format This file format is very similar to CSV except all non-numeric values such as 
over-range and under-range are shown with a single hyphen character. 

Field settings button 

Allows selection of columns to be stored and their order. 

 

The columns to be stored and their order within the file can be specified.  Choose the ‘Format...’ button to 
access the ‘Column Order’ editor.  Select the columns to be saved from the list on the left-hand side.  They are 
grouped by instrument type.  Choose the instrument type and then select the channels to be saved.  Multiple 
channels can be selected at the same time.  Click the right arrow button to move the chosen channels to the 
‘Selected Channels’ column. 

Columns from more than one instrument type can be chosen.  Most channels appear in most instrument types.  
A channel only has to be selected once. 

Note: If the user decides not to include a channel and then later add that channel to the selected list, any 
existing files will still only contain the original columns. 

 
When downloading, save data from 
new unreferenced channels 

This option allows the user to be sure that when a new channel is 
added to an instrument but it is not listed in either the selected or 
available channels no data is lost when downloading. 

 

Note: Turn this feature off when using MS Excel macros that are expecting a predefined data format. 

 
Include channels containing no data When this option is ticked channels that do not have any valid values 

stored will be included as an empty column; otherwise the column is 
excluded. 

Select ‘Save’ to store the changes.  These settings will be used each time the user downloads readings from the 
instrument(s). 

Secure 

Tick this box to have a code value inserted into CSV or Tab separated text files.  The value inserted into the text 
file can be used to ensure that the data in the file has not been tampered with.  The code formula is not 
published.  A stand-alone software component to enable the scanning of a file to ensure its validity is available 
from Geotechnical Instruments UK Ltd. 
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Identify readings using instrument serial number 

This option is only available when the file format is set to Monitor Pro. Ticking this box will cause the source 
parameter to use the instrument serial number. Otherwise source is labelled ‘Field Reading’. 

Filename format 

Select a file naming convention from the dropdown list or type in your own filename format. The extension (.csv, 
.txt or .mpr) is automatically appended to the filename. 

Formatting strings that can be applied to the filename: 

[ComputerName] Adds the name of the computer to the filename. 

[UserName]  Adds the name of the authenticated user of this computer. 

[LRDate]  Adds the date of the last reading in yymmdd format. 

[LRTime]  Adds the time of the last reading in the hhmmss format. 

[DLDate]  Adds the date the data was downloaded in yymmdd format. 

[DLTime]  Adds the time the data was downloaded in yymmdd format. 

[SerialNo]  Adds the serial number of the instrument to the filename. 

 

Include additional information in files 

If this option is selected, the CSV files will include the following parameters when the file is saved: Instrument 
type, serial number, time of download, calibration and service dates. 

Calibration information 

Post 2007 (serial numbers >10000) GA/GEM2000 instruments and G5000 series instruments fitted with V1.12 or 
later can include user calibration data in the downloaded readings. 

 

Do not include Information is excluded 

Include in header section The user calibration data is included in the title section block of the data file. 

Include in-line with readings The user calibration data is included in line with readings in date order. This 
option may make processing of CSV using external software more difficult. 

 

Automatically process after downloading If wishing to email, file copy or FTP the file, tick this box to have 
the operation occur automatically after the data has been 
downloaded from the instrument. 

Email readings Specify an email address to send the file to.  The file is sent as an 
attachment in a plain text email.  The PC must have a MAPI 
compatible mail client installed such as Microsoft Outlook.  
When the email is sent after downloading, some versions of 
Outlook will send a warning that an external application is trying 
to access Outlook.  When this prompt appears the external 
request must be accepted. 
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Multiple addresses can be specified by separating each address with a semicolon (no spaces). 

Copy to specified folder Enter a local path name or UNC path name to copy the 
downloaded file to after downloading has completed.  This will 
be an additional copy of the readings to that stored in this 
application's data folder. 

Send readings to an FTP server Specify an FTP server address.  This may be a URL or IP address, 
a user name and password. These settings will be available from 
the user’s system administrator. 

Downloading readings 

After configuring the software to download readings, select the ‘Download’ button on the toolbar or select 
’Download Readings’ from the ‘Instrument’ menu.   

The status window appears and shows the progress of the download.  After downloading the readings are saved 
in the specified format and processed if the automatic process option was selected. The file is shown.  If FTP was 
selected, the file will be FTP’d to the specified location.  If email was selected the file will be sent as an email 
attachment to the chosen email address.   

With pre-2007 GEM2000 analysers (serial number < 10000), ‘GA mode’ and ‘GEM mode’ are stored separately 
within the instrument. 

When downloading readings from the post 2007 (serial number > 10000) GEM2000 analysers, the software will 
download the readings from both of the operating modes automatically. The data will be stored in separate files, 
whereas, GEM5000 readings are combined as a single download. 

Data security 

Gas Analyser Manager includes a facility for ensuring that data is secure by making changes to the readings file 
evident when viewed in Gas Analyser Manager.  To use this facility, data from the instrument needs to be stored 
in the ‘Secure CSV’ format.  

The ‘Secure CSV’ format incorporates a validation code that will identify if any changes have been made to the 
data.  The validation code formula is not published.  A stand-alone software component to scan a file to ensure 
its validity is available from Geotechnical Instruments (UK) Ltd. For further information please contact the 
Technical Support Team on +44(0)1926 338111 or technical@geotech.co.uk. 

An additional security feature is that data can be sent via either email or FTP to a remote location directly from 
the instrument. 

Viewing downloaded readings 

Below the ‘All Received Readings’ tree item on the ‘Sites’ tab is a list of all reading files downloaded. The view of 
the files is unfiltered. Under each ‘Site’ a filtered view of the readings file that only shows IDs applicable to the 
site borehole ID mask can be seen. 

To view the downloaded readings in an external program right click the file and choose ‘Open using Excel’ from 
the context menu.  The file will be opened using the registered program for CSV file extensions. If using all-
numeric IDs, Microsoft Excel automatically determines this to be a numeric value and will truncate leading zeros. 
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Figure 36 - Example of readings opened using Microsoft Excel 

The readings data is automatically displayed in separated cells within the worksheet.  The data can now be 
analysed, reported and graphed using the MS Excel application. 
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PROBLEM SOLVING  

Message Action required 

I can't get my USB communications lead to work. Check ‘Windows Device Manager’ to ensure the USB 
driver is installed.  Check the USB port has a COM 
port number mapped and that the port is assigned on 
‘Tools’ then ‘Options’. 

Every time I store a reading the analyser asks if there 
is a H2S filter attached, how do I stop this message 
appearing? 

This message can be configured to be ID specific. Use 
Gas Analyser Manager (GAM) to toggle the H2S filter 
flag accordingly. 

I have just used my flow pod with my GA2000 and 
after downloading the results, the flow data isn't 
there. 

It is likely that the reading was stored before the 
logging period had elapsed. The logging period must 
be allowed to run its course. 

I have recently purchased a new GA2000 plus and 
noticed the residual nitrogen feature. Can I have this 
feature enabled for my other earlier gas analysers? 

No.  The memory has been extended on your new 
analyser allowing us to add features such as this. 
However, if using the latest version of Gas Analyser 
Manager, the residual Nitrogen can be calculated and 
downloaded as an extra channel. 

I have tried to load my GA2000 with a second set of 
IDs but when I do, the first set of IDs is over-written. 

To upload more than set of IDs from different groups 
of sites, you need to use the ‘Routes' facility which 
can be found in Gas Analyser Manager. 

I am using Gas Analyser Manager and my data and ID 
have disappeared. 

Check that your ‘Data Folder' is set to the correct 
location of your files. This can be found in the ‘Tools' 
menu then ‘Options'. 

Automatic detection could not be started; the port 
may be in use by another application. 

Check the analyser is connected to the PC and that 
the USB port has a COM port number mapped.  
Select ‘OK’ to continue and assign a port number by 
accessing ‘Tools’ then ‘Options’. 

 

Note: For further information please contact Technical Support at Geotechnical Instruments (UK) Limited on 
+44(0)1926 338111 or email technical@geotech.co.uk. 

 

  



   Page 59 of 59 

Operating Manual 

OMGAM – Iss. 2   Copyright – Geotechnical Instruments (UK) Ltd 

GAM 

GLOSSARY OF TERMS 

5000 series The 5000 series refers to the GA5000, GEM5000 and BIOGAS 5000 range of gas 
analysers. 

Administrator The Administrator for the PC (Client) onto which Gas Analyser Manager is to be 
installed and who has the required security privileges needed to install and 
remove Gas Analyser Manager program files. 

Borehole A borehole, also known as a sample point, is a single point on a site that is 
identified by a text label of between 8 and 12 characters.  The borehole can be a 
well head, borehole or any fixed point where a gas measurement is taken. 

Borehole groups A borehole group identifies a set of boreholes within a site. 

Comment file A comment file defines a list of 64 text strings that are used for selection choice 
for site or borehole specific questions. 

Connected devices Instruments (analysers) currently connected to the PC via USB port(s).   

Download Transmission of data from the instrument to the GAM application (IDs, readings, 
questions etc). 

Firmware Firmware is the name given to the analyser’s internal software.  The firmware is 
automatically updated when the analyser is returned for servicing. 

GAM Geotech’s abbreviation for Gas Analyser Manager. 

Question files Question files define up to five site questions.  Four styles of question are 
available. 

Route A route is a mechanism that allows the pre-selection of several sites, borehole 
groups or individual boreholes for simultaneous uploading to an instrument. 

Service due date The date the next service is due for the selected device.  Instrument icons are 
highlighted in red in the application, indicating that the instrument is past its 
service due date. 

Site A site is a group of boreholes within a common location. 

Upload Transmission of data from the GAM application to the instrument (IDs, question 
files, comment files etc). 
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